
1 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

 

 

 

 

 

 

 
Technical Report 

VMware vCloud Director on NetApp Clustered 
Data ONTAP Deployment Guide 
Jack McLeod, Sushil Kumar, NetApp 

August 2013 | TR-4203 | Version 1.0  



2 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

TABLE OF CONTENTS 

1 Solution Overview ................................................................................................................................ 5 

 Overview ....................................................................................................................................................5 1.1

 VMware vCloud Director 5.1 Overview .......................................................................................................5 1.2

 Target Audience .........................................................................................................................................5 1.3

 Key Terminologies and Components ..........................................................................................................5 1.4

 Solution Overview .......................................................................................................................................7 1.5

 Solution Hardware Components .................................................................................................................8 1.6

2 Setup Storage ....................................................................................................................................... 8 

 Aggregates 64-Bit Clustered Data ONTAP .................................................................................................8 2.1

 Create a SVM (formerly VServer) for vCloud..............................................................................................9 2.2

 NFSv3 Clustered Data ONTAP ................................................................................................................ 10 2.3

 FlexVol Clustered Data ONTAP ............................................................................................................... 11 2.4

 DNS Clustered Data ONTAP .................................................................................................................... 11 2.5

 User Access for Clustered Data ONTAP .................................................................................................. 11 2.6

3 VMware vSphere 5.1 Basic Networking Prerequisites for Clustered ONTAP .............................. 12 

 Configure Networking for Storage ............................................................................................................ 12 3.1

 Configure Flow Control ............................................................................................................................. 12 3.2

 Create Interface Groups for Link Aggregation .......................................................................................... 14 3.3

 Create VLANs ........................................................................................................................................... 16 3.4

 Create Network Failover Groups .............................................................................................................. 17 3.5

 System Manager Setup for NFS and LIFs ................................................................................................ 19 3.6

4 Configure ESXi Storage Networking ................................................................................................ 30 

 Configure ESXi Storage Networking for Physical NICs ............................................................................ 30 4.1

 Configure Flow Control ............................................................................................................................. 33 4.2

 Create and Configure vSwitch and VMkernel Port for Storage Networking .............................................. 34 4.3

 Transition Network to Distributed Switching ............................................................................................. 41 4.4

5 VSC 4.1 ................................................................................................................................................ 48 

 VSC 4.1 System Requirements ................................................................................................................ 49 5.1

 Install VSC 4.1 .......................................................................................................................................... 50 5.2

 VMware vSphere 5 Thin Provisioning Using VSC .................................................................................... 54 5.3

6 NetApp NFS Plug-In 1.0 for VMware VAAI ....................................................................................... 59 

 Enable the VAAI for NFS .......................................................................................................................... 59 6.1



3 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

 Install NetApp NFS Plug-In for VMware VAAI .......................................................................................... 59 6.2

7 VMware vCloud Director 5.1 Setup ................................................................................................... 62 

 Install vCloud Director 5.1 ........................................................................................................................ 62 7.1

 VMware vCloud Director 5.1 vShield Manager ......................................................................................... 63 7.2

 VMware vCloud Director 5.1 Storage ....................................................................................................... 74 7.3

 VMware vCloud Director 5.1 Provider ...................................................................................................... 80 7.4

 VMware vCloud Director 5.1 Network Pools Isolation-Backed ................................................................. 87 7.5

 VMware vCloud Director 5.1 Organization ............................................................................................... 90 7.6

 Setup Catalogs and vApps ..................................................................................................................... 103 7.7

8 Snap Creator Setup .......................................................................................................................... 115 

 Snap Creator 4.0 Preinstallation ............................................................................................................. 115 8.1

 Install Snap Creator Server .................................................................................................................... 117 8.2

 Snap Creator 4.0 Plug-In for VMware vCloud Director ........................................................................... 122 8.3

9 Conclusion ........................................................................................................................................ 134 

References ............................................................................................................................................... 134 

Supporting Documents ....................................................................................................................................... 134 

Version History ....................................................................................................................................... 134 

LIST OF TABLES 

Table 1) VMware vSphere 5.1 basic networking prerequisites for clustered ONTAP. ................................................. 12 

Table 2) System Manager setup for NFS and LIFs prerequisite. ................................................................................. 19 

Table 3) LIF configuration information. ........................................................................................................................ 19 

Table 2) Prerequisites for VSC 4.1. ............................................................................................................................. 48 

Table 3) Prerequisites for VMware vCloud Director 5.1............................................................................................... 62 

Table 4) Prerequisites for Snap Creator 4.0 Server Windows. .................................................................................. 117 

LIST OF FIGURES 

Figure 1) NetApp vCloud solution overview diagram. .................................................................................................... 8 

Figure 2) Configure flow control. ................................................................................................................................. 13 

Figure 3) Set flow control administrative...................................................................................................................... 14 

Figure 4) Create interface group for link aggregation. ................................................................................................. 15 

Figure 5) Name interface group. .................................................................................................................................. 15 

Figure 6) Edit interface group. ..................................................................................................................................... 16 

Figure 7) Create VLAN. ............................................................................................................................................... 17 

Figure 8) Manage failover groups. ............................................................................................................................... 18 

Figure 9) Manage failover group. ................................................................................................................................ 18 



4 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

Figure 10) Check connectivity physical NICs. ............................................................................................................. 31 

Figure 11) Add networking:  Virtual Machine network. ................................................................................................ 31 

Figure 12) Add networking:  Select unused adapters. ................................................................................................. 32 

Figure 13) Add networking:  name port group. ............................................................................................................ 32 

Figure 14) Add networking:  Network setup complete. ................................................................................................ 33 

Figure 15) View Cisco Discover Protocol information. ................................................................................................. 33 

Figure 16) Configure storage networking:  Create VMkernel port. .............................................................................. 35 

Figure 17) Create storage networking:  Name VMkernel port. .................................................................................... 36 

Figure 18) Create storage networking:  Assign IP address to VMkernel port. ............................................................. 37 

Figure 19) Create storage networking:  Verify storage networking configuration. ....................................................... 38 

Figure 20) Create storage networking:  Edit vSwitch properties. ................................................................................. 39 

Figure 21) Create storage networking:  Set MTU for jumbo frames. ........................................................................... 39 

Figure 22) Create storage networking:  Set IP hash option. ........................................................................................ 40 

Figure 23) Create storage networking:  Vmk-storage properties. ................................................................................ 40 

Figure 24) vCenter networking. ................................................................................................................................... 41 

Figure 25) Create dvSwitch:  New vSphere Distributed Switch. .................................................................................. 41 

Figure 26) Create dvSwitch:  Select dvSwitch version. ............................................................................................... 42 

Figure 27) Create dvSwitch:  Select number of uplink ports. ....................................................................................... 43 

Figure 28) Create dvSwitch:  Add hosts to dvSwitch. .................................................................................................. 43 

Figure 29) Create dvSwitch: Verify information. .......................................................................................................... 44 

Figure 30) Create dvSwitch: Convert current settings. ................................................................................................ 44 

Figure 31)  Manage dvSwitch Hosts. ........................................................................................................................... 45 

Figure 32) Select dvSwitch Hosts. ............................................................................................................................... 45 

Figure 33) Select vmnics for dvSwitch Hosts. ............................................................................................................. 46 

Figure 34) Verify dvSwitch settings. ............................................................................................................................ 46 

Figure 35) Migrate virtual machines for dvSwitching. .................................................................................................. 47 

Figure 36) Verify settings for dvSwitch migration. ....................................................................................................... 48 

 

  



5 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

1 Solution Overview 

 Overview 1.1

This deployment guide provides information about the processes needed for setting up the representative 

environment depicted and in turn steps for deploying other vCloud environments can be extrapolated 

from it. For environments based on these processes, additional steps or components may need to be 

setup. The following steps are specified as reference for vCloud administrators, architects, and engineers 

for setting up their own environments. 

 VMware vCloud Director 5.1 Overview 1.2

Cloud computing improves efficiency by enabling pooling and on-demand consumption of IT resources so 

that businesses can meet their needs in a more agile and cost-effective manner. Through the virtualized 

services of cloud computing, users can consume compute, storage, and network resources only when 

needed. Many services are paid only upon usage, and cloud computing offers consumers the ability to 

deploy their environments at their leisure. Cloud computing can exist as an internal cloud, which means 

that it is built inside an enterprise firewall, or as an external cloud, which means that it is hosted externally 

by a service provider that specializes in providing cloud services. 

VMware
®
 provides a full suite of products and solutions for service providers and enterprises to build 

cloud services called the VMware vCloud
®
 Suite. The vCloud Suite includes the following products: 

 VMware vSphere
™

 

 vCloud Director
®
 

 vCloud Connector 

 vCloud Networking and Security (formerly vShield
™

) 

 VMware vCenter
™

 Site Recovery Manager 

 vCenter Operations Management Suite 

 vFabric Application Director 

 vCloud Automation Center 

A service provider or enterprise customer who is building a vCloud infrastructure as a service (IaaS) today 

would use all of these products. 

 Target Audience 1.3

The target audience for this document includes the following groups: 

 Technical decision makers. This document describes the value of using VMware vCloud Director
®
 

5.1 and clustered Data ONTAP to create a cloud environment that service providers, private-sector, 

and public-sector organizations to meet their respective needs. 

 VMware and NetApp partners and implementors. It is important for VMware and NetApp partners 

to understand the NetApp vCloud solution architecture in order to meet and exceed customer 

requirements and expectations for their cloud solutions. 

 Key Terminologies and Components 1.4

Infrastructure and Operations 

This document references the following VMware infrastructure and operations components: 
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 vSphere resources include the vCenter Servers, VMware ESX
®
 hosts, resource pools, datastores, 

vNetwork Distributed Switches (vDSs), and port groups that are used to provision cloud resources in 
VMware vCloud Director. 

 vCenter Chargeback allows cost models to be customized to the process and the policies of different 
organizations. VMware vCenter Server

™
 collects virtual machine (VM) resource consumption data to 

provide the most complete and accurate tabulation of resource costs. Integration with VMware vCloud 
Director and vShield also enables automated chargeback for private and public cloud environments. 
For more information, refer to Private Cloud Computing. 

 The vCloud Networking and Security solution provides perimeter security enforcement and isolation 
for each tenant in the vCloud environment. It provides single-pane-of-glass firewall rules for 
configuration and enforcement and is fully integrated with Cisco Nexus

®
 1000V for network service 

orchestration. 

 vCenter Orchestrator
™

 (vCO) provides out-of-the-box workflows that can help administrators 
automate existing manual tasks. Administrators can use sample workflows from the vCO workflow 
library to provide a blueprint for creating additional workflows. NetApp fully integrates with vCO by 
using NetApp OnCommand

®
 Workflow Automation to provide storage services for cloud 

environments. 

 vCenter Operations Management Suite (vCOPS) provides performance-monitoring capability to the 
virtualized infrastructure. vCOPS monitors infrastructure resource utilization to verify that 
infrastructure resource capacity is in compliance with the enterprise and service provider’s predefined 
threshold. 

 vCenter Update Manager is an integrated vSphere host patching solution that upgrades, patches, and 
installs third-party components on VMware ESXi

™
 server hosts. 

Cloud Resources 

This report uses the following VMware vCloud Director terms: 

 Cloud cells are the Red Hat Enterprise Linux
®
 5 (RHEL5) servers that run the VMware vCloud 

Director software. Multiple cloud cells form the VMware vCloud Director cluster. 

 Provider virtual data centers (vDCs) are groups of compute, memory, and storage resources from 
one vCenter instance. Portions of a provider vDC can be allocated to an organization by using 
VMware vCloud Director. 

 External networks use networks in vSphere to connect to networks outside of the consumer’s cloud. 
The network can be a public network such as the Internet or an external virtual private network (VPN) 
that connects to a given organization. 

 Organizations are the fundamental grouping in VMware vCloud Director. An organization contains 
users, the virtual applications (vApps) they create, and the resources the vApps use. An organization 
can be a department within a company or an external customer to which a consumer provides cloud 
resources. 

 Organization vDCs provide an organization with the compute, memory, storage, and network 
resources required to create vApps. 

 Network pools are collections of VM networks that are available to be consumed by vDCs to create 
vApp networks and by organizations to create organization networks. Network traffic on each network 
in a pool is isolated from all other networks at layer 2. 

 vApps are virtual applications that contain one or more VMs. 

 Catalogs are virtual repositories that allow consumers to share vApp templates and media images 
with other users in their organization or with other organizations in VMware vCloud Director. 

 Storage profiles are a means of classifying storage to be consumed by vCloud Director. Classification 
can occur automatically by discovering storage capabilities through vStorage application 
programming interfaces (APIs) for storage awareness (VASA) or through user-defined storage 
capabilities. 

http://www.vmware.com/products/datacenter-virtualization/vcenter-server/overview.html
http://www.vmware.com/products/datacenter-virtualization/vcloud-director/overview.html
http://www.vmware.com/products/datacenter-virtualization/vcloud-director/overview.html
http://www.vmware.com/cloud-computing/private-cloud/index.html
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Storage Resources 

This report uses the following NetApp storage terms: 

 NetApp FlexClone
®
 storage technology instantly replicates data volumes and datasets as 

transparent, virtual copies without requiring additional storage space or compromising performance. 

 NetApp Snapshot
™

 point-in-time copy technology enables data protection with no performance 
impact and minimal consumption of storage space. 

 NetApp Snap Creator
™

 provides the ability to back up and recover vApps in a vCloud Director 
environment by using Snapshot copies. 

 NetApp SnapMirror
®
, a NetApp data replication solution, provides DR protection of business-critical 

data and enables a DR site for other business activities. 

 NetApp SnapVault
®
, a NetApp disk-to-disk backup feature for Data ONTAP, allows the retention of 

large numbers of Data ONTAP Snapshot copies and provides point-in-time backup copies in native 
format. 

 Interface group (ifgrp) or EtherChannel is a mechanism that supports aggregation of network 
interfaces into one logical interface unit. After it is created, an ifgrp is indistinguishable from a physical 
network interface. Ifgrps are used to provide fault tolerance of the network connection and, in some 
cases, higher throughput to the storage device. 

 NetApp Virtual Storage Console (VSC), a plug-in to VMware vCenter, is available for all vSphere 
clients that connect to vCenter. It provides storage configuration and monitoring using VSC 4.1 
capability, datastore provisioning, VM cloning by using the provisioning and cloning capability, and 
backup and recovery of VMs and datastores through the backup and recovery capability. 

 Solution Overview 1.5

The solution described in this section is designed to be a representative solution for putting best practices 

in place for clustered Data ONTAP and vCloud Director 5.1. Although this is a small solution, it should 

easily scale to support the requirements of an organization.  
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Figure 1) NetApp vCloud solution overview diagram. 

 

 Solution Hardware Components 1.6

The following hardware components are required to support this solution: 

 Two FAS3200 series or FAS6200 series storage controllers 

 Two disk shelves of 15K SAS 450GB disk drives and one disk shelf of 2TB 7K SATA drives 

 Two 10GbE ports per controller 

 Eight servers based on Intel
®
 (four for infrastructure and four for the vCloud Director environment), 

each equipped with the following: 

 192GB of RAM 

 Two eight-way processors 

 Two 10GbE network interface cards (NICs) 

 Two 10GbE switches 

 Port channel, port bundle, Ether Channeling, or vPC capability 

 Twelve 10GbE ports (six on each switch) 

 This port count does not include the core uplink ports. Note:

2 Setup Storage 

 Aggregates 64-Bit Clustered Data ONTAP 2.1

A 64-bit aggregate containing the root volume is created during the Data ONTAP setup process. To 

create additional 64-bit aggregates, determine the aggregate name, the node on which to create it, and 

number of disks it will contain. 
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An aggregate for Gold and Silver level storage needs to be created. This aggregate will have 15K SAS 

drives. The difference between the two levels of storage will be the backup and recovery options. To 

create a new aggregate, complete the following step: 

1. Run the following command: 

aggr create -aggregate vcloud_aggr1 -nodes node1 -B 64 -diskcount 32 

An aggregate for Bronze level storage and the vCloud catalog needs to be created. This aggregate will 

have SATA drives, which will have lower performance than SAS drives, but much higher storage space. 

To create a new aggregate, complete the following step: 

2. Run the following command: 

aggr create -aggregate vcloud_aggr2 -nodes node2 -B 64 -diskcount 32 

 Leave at least one disk (select the largest disk) in the configuration as a spare. A best Note:
practice is to have at least one disk spare for each disk type and size. 

 Create a SVM (formerly VServer) for vCloud 2.2

To create the first Vserver, complete the following steps: 

1. Run the Vserver setup wizard. 

Welcome to the Vserver Setup Wizard, which will lead you through 

the steps to create a virtual storage server that serves data to clients. 

  

You can enter the following commands at any time: 

"help" or "?" if you want to have a question clarified, 

"back" if you want to change your answers to previous questions, and 

"exit" if you want to quit the Vserver Setup Wizard. Any changes 

you made before typing "exit" will be applied. 

  

You can restart the Vserver Setup Wizard by typing "vserver setup". To accept a default 

or omit a question, do not enter a value. 

  

Step 1. Create a Vserver. 

You can type "back", "exit", or "help" at any question. 

2. Enter the Vserver name vcloud_vserver01. 

Enter the Vserver name: vcloud_vserver01 

3. Select the Vserver data protocols to configure. If you are uncertain, select all of them. 

Choose the Vserver data protocols to be configured {nfs, cifs, fcp, iscsi}: nfs, cifs 

4. Select the Vserver client services to configure. If you are uncertain, select all of them. 

Choose the Vserver client services to configure {ldap, nis, dns}: dns 

5. Enter the Vserver’s root volume aggregate, in this case vcloud_aggr1. 

Enter the Vserver's root volume aggregate {aggr01, aggr02} [aggr02]: vcloud_aggr1 

6. Enter the Vserver language setting. English is the default [C]. 

Enter the Vserver language setting, or "help" to see all languages [C]: 

7. Answer No to Do you want to create a data volume? 

Vserver creation might take some time to finish.... 

  

Vserver test01 with language set to C created. The permitted protocols are 

nfs, cifs, fcp, iscsi. 

  

Step 2: Create a data volume 

You can type "back", "exit", or "help" at any question.                
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Do you want to create a data volume? {yes, no} [yes]: 

8. Enter no for all remaining questions regarding service configuration. Individual services can be 

configured at a later time. 

To create the second Vserver, complete the following steps: 

1. Run the Vserver setup wizard. 

Welcome to the Vserver Setup Wizard, which will lead you through 

the steps to create a virtual storage server that serves data to clients. 

  

You can enter the following commands at any time: 

"help" or "?" if you want to have a question clarified, 

"back" if you want to change your answers to previous questions, and 

"exit" if you want to quit the Vserver Setup Wizard. Any changes 

you made before typing "exit" will be applied. 

  

You can restart the Vserver Setup Wizard by typing "vserver setup". To accept a default 

or omit a question, do not enter a value. 

  

Step 1. Create a Vserver. 

You can type "back", "exit", or "help" at any question. 

2. Enter the Vserver name vcloud_vserver02. 

Enter the Vserver name: vcloud_vserver02 

3. Select the Vserver data protocols to configure. If you are uncertain, select all of them. 

Choose the Vserver data protocols to be configured {nfs, cifs, fcp, iscsi}: nfs, cifs 

4. Select the Vserver client services to configure. If you are uncertain, select all of them. 

Choose the Vserver client services to configure {ldap, nis, dns}: dns 

5. Enter the Vserver’s root volume aggregate, in this case vcloud_aggr1. 

Enter the Vserver's root volume aggregate {aggr01, aggr02} [aggr02]: vcloud_aggr2 

6. Enter the Vserver language setting. English is the default [C]. 

Enter the Vserver language setting, or "help" to see all languages [C]: 

7. Answer No to Do you want to create a data volume? 

Vserver creation might take some time to finish.... 

  

Vserver test01 with language set to C created. The permitted protocols are 

nfs, cifs, fcp, iscsi. 

  

Step 2: Create a data volume 

You can type "back", "exit", or "help" at any question.                

  

Do you want to create a data volume? {yes, no} [yes]: 

8. Enter no for all remaining questions regarding service configuration. Individual services can be 

configured at a later time. 

 NFSv3 Clustered Data ONTAP 2.3

To configure NFS on the Vserver, run the following command: 

1. Install the NFS license. 

license add -license-code vcloud_vserver01  

license add -license-code vcloud_vserver02 
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 FlexVol Clustered Data ONTAP 2.4

1. The following information is required for creating a flexible volume: the volume’s name and size, and 
the aggregate on which it will exist.  

2. Create a volume called <<vcloud_gold1>> on aggregate vcloud_aggr1. with a size of 1TB, run the 

following commands: 

volume create -vserver vcloud_vserver01 -volume vcloud_gold1 -aggregate vcloud_aggr1 -size 1000g 

-state online -type RW –policy default -snapshot-policy none 

3. Create a volume called <<vcloud_silver1>> on aggregate vcloud_aggr1 with a size of 1TB, run the 

following commands: 

volume create -vserver vcloud_vserver01 -volume vcloud_silver1 -aggregate vcloud_aggr1 -size 

1000g -state online -type RW –policy default -snapshot-policy none 

4. Create a volume called <<vcloud_bronze1>> on aggregate vcloud_aggr2 with a size of 1TB, run the 

following commands: 

volume create -vserver vcloud_vserver02 -volume vcloud_bronze1 -aggregate vcloud_aggr2 -size 

1000g -state online -type RW –policy default -snapshot-policy none 

5. Create a volume called <<vcloud_catalog1>> on aggregate vcloud_aggr2 with a size of 1TB, run 

the following command: 

volume create -vserver vcloud_vserver02 -volume vcloud_catalog -aggregate vcloud_aggr2 -size 

1000g -state online -type RW -policy default -snapshot-policy none 

 DNS Clustered Data ONTAP 2.5

To configure DNS, complete the following step: 

1. Run the following command for the Vserver: 

vserver services dns create -vserver vcloud_vserver01 -domains <<your domain name here>> -name-

servers <<YOUR IP HERE>> -state enabled 

 

vserver services dns create -vserver vcloud_vserver01 -domains <<your domain name here>> -name-

servers <<YOUR IP HERE>> -state enabled 

 User Access for Clustered Data ONTAP 2.6

Best Practice 

Delete or lock the default admin account. 

There are two default administrative accounts: admin and diag. The admin account serves as an 

administrator and is allowed access using all applications. To set up user access for clustered Data 

ONTAP, complete the following steps:  

1. Create a log-in method for a new administrator from ClusterShell. 

security login create –username vcloud -authmethod password -role admin -application ssh 

security login create –username vcloud -authmethod password -role admin -application http 

security login create –username vcloud -authmethod password -role admin -application console 

security login create –username vcloud -authmethod password -role admin -application ontapi 

security login create –username vcloud -authmethod password -role admin -application service-

processor 

2. Lock the default admin account. 

security login lock –username admin 
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3 VMware vSphere 5.1 Basic Networking Prerequisites for Clustered 

ONTAP 

Table 1) VMware vSphere 5.1 basic networking prerequisites for clustered ONTAP. 

 Prerequisites 

 A NetApp cluster running Data ONTAP 8.1 or later operating in clustered ONTAP is required. 

 NetApp OnCommand System Manager 2.0 or later is required. 

 vSphere 5 (including ESXi 5, vCenter 5, and vSphere Client) is required. 

 Configure Networking for Storage 3.1

To configure networking, complete the following tasks: 

1. Establish physical connections to switches. 

2. Configure physical switches: 

a. Link aggregation 

b. Flow control 

c. Spanning tree 

d. Jumbo frames or MTU 

e. VLANs 

3. Configure NetApp cluster nodes: 

a. Ports 

b. Interface groups 

c. VLANs 

d. MTU 

e. Flow control 

f. Failover group and port, interface group, and/or VLAN assignments 

4. Configure Storage Virtual Machine networking for vSphere use: 

a. System Manager Vserver Setup wizard, including networking 

b. LIFs appropriate to the protocol 

c. Failover group for NSF LIFs 

5. Configure ESXi servers: 

a. Physical NICs, including flow control 

b. vSwitches, including link aggregation and MTU 

c. VMkernel port, including VLAN, MTU, IP address, and netmask 

d. VM port group for VM-to-storage access (optional), including VLAN and consistent port group 
name on all ESXi servers 

 Configure Flow Control 3.2

Configure Flow Control on Cluster-Node Ports 

Flow control is configured on each physical port, even if it is a member of an interface group. 

Note: Some models of Ethernet adapter do not allow flow control to be configured. 
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Note: Changing flow control settings disrupts the network connection for several seconds. 

Configure Flow Control Using Element Manager 

To configure flow control by using Element Manager, complete the following steps on each node in the 

cluster: 

1. Enter the IP address or FQDN of the cluster management LIF in the web browser to access Element 
Manager. 

2. Log in to Element Manager as the cluster administrator. 

3. Navigate to Network > Port > Manage. 

4. In the node drop-down list, select the first node. 

5. Click the port to be configured. 

Figure 2) Configure flow control. 

 

6. Set Flow Control Administrative to none. 
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Figure 3) Set flow control administrative. 

 

7. Click modify. 

8. Click Please Continue to move past the warning. 

9. To get back to the list of interfaces for this node, select a different node in the node drop-down list, 
then select this node again. 

10. Repeat steps 5 through 9 to configure each port used for ESXi-to-storage networking. 

Configure Flow Control Using CLI 

To configure flow control at the CLI, complete the following steps: 

1. Log in to the ClusterShell through SSH or the console port of a node. 

2. Disable flow control. 

vice::> net port mod -node <node> -port <port> -flowcontrol-admin none  

For example: 

vice::> net port mod -node vice-01 -port e0d -flowcontrol-admin none 

3. Repeat step 2 for each port used for ESXi datastore connectivity. 

 Create Interface Groups for Link Aggregation 3.3

Before configuring the NetApp cluster nodes for link aggregation, verify that the switches are configured, 

the properties of the channels or teams are known, and that the ports of each node are connected to the 

correct switch ports. 

To create interface groups for link aggregation, complete the following steps: 

1. In System Manager, navigate to Storage Controllers > <node-01> > Configuration > Ports/Adapters. 
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Figure 4) Create interface group for link aggregation. 

 

2. Click Create Ifgroup. 

3. Name the interface group. The name must start with the letter a, followed by a number, and then a 

letter. Use the same name for the equivalent interface group on each node. 

Figure 5) Name interface group. 

 

4. Select the ports for the interface group. 

5. Select the correct mode according to the capabilities and settings of the switch: 

 If the switch ports are properly channeled or bundled and LACP is enabled, select LACP. 

 If the switch ports are properly channeled or bundled, but LACP is not enabled or supported, 
select Multiple. 
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 If the switch ports are not properly channeled or bundled, or if the switches are not stackable or 
otherwise not capable for this feature, select Single. 

6. Select IP-based as the type of load distribution. 

7. Click Create. 

8. Once the interface group is created, select it, and then click Edit. 

Figure 6) Edit interface group. 

 

9. Set the MTU size to 9,000 if jumbo frames are used and the switches are properly configured. 

10. Click Edit to save the change. 

11. Repeat this procedure for each interface group on each node in the NetApp cluster. 

 Create VLANs 3.4

To create VLANs, complete the following steps: 

1. In System Manager, navigate to Storage Controllers > <node-01> > Configuration > Ports/Adapters. 
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Figure 7) Create VLAN. 

 

2. Click Create VLAN. 

3. Select the physical interface (port or interface group) on which to create the VLAN interface. 

4. Enter the VLANs one at a time, and click Add after you enter each one. All VLANs entered in one 
dialog box are created on the same physical interface. 

5. Click Create. 

6. Repeat this procedure for all VLANs on all nodes. 

 Create Network Failover Groups  3.5

Failover groups are created by adding a port, an interface group, or a VLAN interface to an undefined 

failover group. The first interface is added from the CLI. 

To create failover groups, complete the following steps: 

1. Log in to the ClusterShell through SSH or the console port of a node. 

2. Create a failover group. 

vice::> failover-groups create -failover-group <fo_group> -node <node> -port <port_ifgrp_or_vlan> 

For example: 

vice::> failover-groups create -failover-group private -node vice-01 -port a0a 

3. Add the remaining interfaces to the failover group, using the same command syntax or using Element 
Manager. 

4. In Element Manager, navigate to Network > Interface > Failover Groups > Manage. 
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Figure 8) Manage failover groups. 

 

5. Click Create New Entry. 

6. Select the failover group and node from the drop-down lists. 

7. Place the cursor in the Port field, and press the spacebar. 

8. Select the port, interface group, or VLAN interface to add to the failover group. 

Figure 9) Manage failover group. 

 

9. Click Create. 

10. Click Duplicate to get back to the Create window with all prefilled fields. 

11. Make any changes to the fields. If adding the same interfaces on all nodes, simply change the node. 
Click Create. 
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12. Repeat the preceding steps to add all appropriate ports, interface groups, or VLANs to each failover 
group. 

 System Manager Setup for NFS and LIFs  3.6

Table 2) System Manager setup for NFS and LIFs prerequisite. 

Description 

System Manager 2.0R1 or later is required. 

After a new Vserver is created, the Vserver Setup wizard walks the user through the steps to set up the 

protocol configuration. All the protocols that were selected for the new Vserver on the Vserver creation 

page are listed and can be configured separately. 

Best Practice 

Provision a separate logical interface (LIF) for each datastore on the node that owns the aggregate that 

will contain the volume for the datastore. 

Configure NFS and LIFs for NFS Datastores 

To configure NFS on a new Vserver, complete the following steps: 

1. Prepare for the NFS configuration task. Create a list showing the planned volumes and their 
containing aggregates and nodes, the home ports for the LIFs, the planned LIF names, and the IP 
addresses and subnet information. This list will be used later in this procedure. 

Table 3) LIF configuration information. 

Datastore/Volume Aggregate Node Network Port LIF IP Address/Netmask 

vcloud_gold1 vcloud_aggr1 vice-03 a0a nfs1 172.1.2.104 255.255.255.0 

vcloud_silver1 vcloud_aggr1 vice-02 a0a nfs2 172.1.2.105 255.255.255.0 

vcloud_bronze1 vcloud_aggr2 vice-01 
(moves) 

a0a nfstest 172.1.2.106 255.255.255.0 

vcloud_catalog1 vcloud_aggr2 vice-01 a0a nfs3 172.1.2.107 255.255.255.0 

 Although LIFs are listed next to a datastore, these LIFs might not be selected for that specific Note:
datastore by the Virtual Storage Console (VSC). Listing the LIFs next to a particular datastore 
is simply a method for planning the minimum number of LIFs for each node that contains 
datastores. 

2. On the Status page of the Vserver Setup wizard, select NFS. Click Next. 
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3. Add a LIF for each planned datastore on the node that owns the aggregate. 

a. Click Add. 

 

b. Select NFS for the protocol. 

c. Name the LIF according to the names that you listed in Table 3 (step 1). 

d. Click Select to select a home port. 
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e. Expand the ports on the desired node and select the appropriate port, interface group, or virtual 
local area network (VLAN) interface. Click OK. 

 

f. Enter the IP address and the netmask. 

g. Clear the Gateway field if the LIF is on a private, nonrouted network. 

h. Clear the selection for the Allow Management Access Over This Interface checkbox.  
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 Keep this selection if this LIF is routed to the management network and will be used for the Note:
management of the Vserver. 

 

i. Click OK. 

4. Repeat Steps Click Add through Click OK to create a LIF for each planned datastore on the correct 
node and port. When you finish creating the LIFs. Click Next. 

 

5. Select NFS version 3 checkbox and clear the selection for the NFS versions 2 checkbox (not version 
4 – leave this). 
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6. For Name Service, clear the selection for the NIS checkbox and keep the selection for the Local 
Users checkbox. Click Next. 

 Do not enable NIS or LDAP services unless they are actually provided on your network and Note:
properly configured. Otherwise, you may encounter datastore access issues. 

 

7. The ESXi NFS client requires root access, so a root user and a root group must be created. You must 
add a group before you can add a user. 

a. Click Add Group. 
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b. Enter the name and the ID for the root group and click Add.  

 The group name and ID are not critical but are typically root or daemon, and 0 or 1. Note:

 

c. Enter root for user name and 0 for user ID. Select the group that you created previously and 

click Add. 

 

d. Verify that the root user and root group names resemble the following, especially the user ID for 
the root user. Click Next. 
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8. Review the summary page and click Next. 

 

9. Click Close to complete the wizard or select the next protocol to be configured. 

Create Additional LIFs for NFS Datastores 

To add more LIFs to a NFS datastore after the Vserver is created, complete the following steps: 

1. In System Manager, select Vservers and then select the Vserver that contains the datastore to which 
you are adding the LIF. Select Configuration > Network Interfaces. 
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2. Click Create to open the Network Interface Create wizard. Click Next. 

3. Enter a name for the LIF. Under Role, select Data. Click Next. 
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4. Select NFS as the protocol for the LIF. Click Next.  
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5. On the Network Properties page, click Browse and select a node and a port. 
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6. Enter the IP address and the netmask. Leave the Gateway field blank. 

 

7. Click Next and then click Finish. 

8. LIFs for NFS datastores can also be created from the command line as shown in the following 
example: 

vice::> net int create -vserver vsphere_infra -lif nfs4 -role data -data-protocol nfs -home-node 

vice-03 -home-port a0a -firewall-policy data -address 172.1.2.113 -netmask 255.255.255.0 -

failover-group private 

Assign LIFs to Failover Group 

Failover groups must be created and all appropriate ports, interface groups, and VLANs should be added 

to them before LIFs can be assigned to the failover groups. Failover groups do not apply to LIFs that are 

used for iSCSI, FC, or FCoE. 

To assign LIFs to failover groups, complete the following steps: 

1. Launch Element Manager by pointing your browser to the cluster management LIF of your NetApp 

cluster. Log in as admin. 

2. Navigate to Network > Interface > Manage. 

3. In the second drop-down list at the top, select the Vserver to which you are adding the failover group. 

4. In the for Failover Group Name field, enter a space and the existing failover groups will be listed. 
Select a failover group name. 
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5. Set Failover Policy to priority. 

6. Set Auto Revert to true. 

7. Set Use Failover Group to enabled. 

8. Select the failover group for the LIF. Make sure that management LIFs, backend or private network 
LIFs, and LIFs for other purposes are added to the appropriate failover group. 

9. Click Modify to save the changes. 

10. Repeat Steps 3 to 9 for all LIFs in the Vserver. 

4 Configure ESXi Storage Networking 

 Configure ESXi Storage Networking for Physical NICs 4.1

Before configuring physical NICs, verify the following items: 

 The physical NICs are connected to the correct switch ports on the correct switches. 

 Switch ports are correctly configured, including channels or teams and VLANs. 

 Spanning tree is disabled or set to portfast on switch ports used for ESXi. 

 Flow control is disabled on switch ports used for ESXi. 

To check connectivity on ESXi physical NICs, complete the following steps: 

1. Launch the vSphere client, logging in to the vCenter server if it is available or to the first ESXi server if 
vCenter is not yet running. 

2. Press Ctrl+Shift+H to go to the Hosts and Clusters view. 

3. Click the server. Select the Configuration tab, and then select Network Adapters. 
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Figure 10) Check connectivity physical NICs. 

 

4. For the network adapters to be used for ESXi storage networking, verify the following items: 

a. Speed is correct and duplex is Full. 

b. Switch should be None unless vSwitches are already configured for storage. 

c. Observed IP ranges may be None If populated, this field should show traffic in the appropriate 

subnet. 

5. If the vmnic cannot be determined, create a temporary vSwitch, and add all unused NICs. 

6. Navigate to Networking > Add Networking (on the upper right). 

7. Select Virtual Machine, and click Next. 

Figure 11) Add networking:  Virtual Machine network. 

 

8. Select all unused adapters. Do not select any adapters that are already part of a vSwitch. Click Next. 
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Figure 12) Add networking:  Select unused adapters. 

 

9. Give the port group a temporary name. Click Next. 

Figure 13) Add networking:  name port group. 

 

10. Click Finish. 
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Figure 14) Add networking:  Network setup complete. 

 

11. Next to the temporary vSwitch, click each of the speech balloon icons to view Cisco Discover Protocol 
information. 

Figure 15) View Cisco Discover Protocol information. 

 

12. Verify the device ID or the system name and port ID to match the physical NIC to the switch port. 

13. Once the physical NICs are mapped out, click Remove next to the temporary vSwitch, and then 
confirm by clicking Yes. 

 Configure Flow Control 4.2

To configure flow control in ESXi from the ESXi shell, complete the following steps: 

1. Log in to the ESXi CLI from the physical console, the remote console of the physical server, or SSH. 

2. Check the current settings for flow control for each physical NIC. 

~ # ethtool -a vmnic2 

Pause parameters for vmnic2: 

Autonegotiate: on 

RX:     on 

TX:     on 

3. Set and verify the flow control settings for each physical NIC. 
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~ # ethtool -A vmnic2 autoneg off rx off tx off 

~ # ethtool -a vmnic2 

Pause parameters for vmnic2: 

Autonegotiate: off 

RX:     off 

TX:     off 

4. Edit /etc/rc.local and append the ethtool -A command for each NIC. 

~ # cp /etc/rc.local /etc/rc.local.save 

~ # echo "ethtool -A vmnic2 autoneg off rx off tx off" >> /etc/rc.local 

~ # echo "ethtool -A vmnic3 autoneg off rx off tx off" >> /etc/rc.local 

 Make sure that there are two greater-than symbols (to indicate the append operation) and Note:
that the vmnic number is changed in these commands. 

 Create and Configure vSwitch and VMkernel Port for Storage Networking 4.3

To create and configure a vSwitch and VMkernal port for storage networking, complete the following 

steps: 

1. Launch the vSphere client, logging in to the vCenter server if it is available or to the first ESXi server if 
vCenter is not yet running. 

2. Navigate to the Hosts and Clusters view. 

3. Navigate to ESXi Host > Configuration > Networking > Add Networking (on the upper right). 

4. Select VMkernel, and click Next. 

5. Select the desired physical NICs for storage networking. Do not select any adapters that are already 
part of a vSwitch. Click Next. 
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Figure 16) Configure storage networking:  Create VMkernel port. 

 

6. Enter a VMkernel name, such as vmk-storage. Use the same name for the same VMkernel network 

on all ESXi servers. 
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Figure 17) Create storage networking:  Name VMkernel port. 

 

7. Set the VLAN if the storage network requires ESX to add a VLAN tag to its traffic. 

8. If the network bandwidth supports vMotion and fault tolerance logging, they can also be selected. 

9. Because the storage network should not be routable, it should not be possible to access the 
management port, so do not select management traffic. Click Next. 

10. Enter an IP address and a netmask for the VMkernel port. Click Next. 
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Figure 18) Create storage networking:  Assign IP address to VMkernel port. 

 

11. Verify the settings shown in the following screenshot. Click Finish. 
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Figure 19) Create storage networking:  Verify storage networking configuration. 

 

12. Click Properties next to the new vSwitch. 
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Figure 20) Create storage networking:  Edit vSwitch properties. 

 

13. Click the vSwitch, and then click Edit. 

14. If using jumbo frames, set the MTU under the General tab. 

Figure 21) Create storage networking:  Set MTU for jumbo frames. 

 

15. Click the NIC Teaming tab. 

16. If using link aggregation on the switches, select the IP hash option next to Load Balancing. If the 
switches do not support or are not configured for link aggregation, select Virtual Port ID or Source 
MAC hash. 
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Figure 22) Create storage networking:  Set IP hash option. 

 

17. Verify that the NICs are active. 

18. Click OK. 

19. Select the VMkernel port, and click Edit. 

20. If using jumbo frames, set the MTU for the VMkernel port. 

Figure 23) Create storage networking:  Vmk-storage properties. 

 

21. Click OK, and then click Close. 
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 Transition Network to Distributed Switching 4.4

Complete the following steps to transition the network to distributed switching. 

1. Before beginning this process, make sure that one vmnic is available to create the dvSwitch. Open 
vCenter and click Home.  

2. Click Networking 

Figure 24) vCenter networking. 

 

3. At the Networking screen, right-click the data center that houses your vCloud infrastructure and select 
New vSphere Distributed Switch. 

Figure 25) Create dvSwitch:  New vSphere Distributed Switch. 

 

4. Choose vSphere Distributed Switch Version: 5.1 and select Next. 
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Figure 26) Create dvSwitch:  Select dvSwitch version. 

 
 

5. Enter a name for the dvSwitch, and select the number of uplink ports you need. Click Next. 
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Figure 27) Create dvSwitch:  Select number of uplink ports. 

 
 

6. Choose Add now and then select the hosts that you want to add to the dvSwitch. Also, select the 
available vmnic. Click Next. 

Figure 28) Create dvSwitch:  Add hosts to dvSwitch. 
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7. Verify that Automatically create a default port group is checked and that all information is correct, and 
click Finish. 

Figure 29) Create dvSwitch: Verify information. 

 
 

8. Convert the current vSwitch settings to the new dvSwitch.  

Figure 30) Create dvSwitch: Convert current settings. 

 
 

9. Right-click the new dvSwitch and select Manage Hosts. 
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Figure 31)  Manage dvSwitch Hosts. 

 
 

10. Select the hosts that you want to manage, and click Next. 

Figure 32) Select dvSwitch Hosts. 

 
 

11. Chose all of the vmnics. By doing this, you will import the current vmnic that is being used by the 
vSwitch to the dvSwitch and regain your network redundancy. Make sure to choose the correct uplink 
port group for the vmnic being imported. Click Next. 
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Figure 33) Select vmnics for dvSwitch Hosts. 

 

12. Verify that each VMkernel is being transitioned to the correct dvPortGroup. This will import all the 
VMkernels that do vMotion, NFS connectivity, and management from your vSwitch to the dvSwitch. 
All IP settings are also transitioned during this process. Click Next. 

Figure 34) Verify dvSwitch settings. 
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13. Unless you have virtual machines to migrate, click Next at this screen. 

Figure 35) Migrate virtual machines for dvSwitching. 

 

14. Verify the settings for the migration, and click Finish. You have now migrated all of your settings from 
the vSwitch to the dvSwitch. 
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Figure 36) Verify settings for dvSwitch migration. 

 

5 VSC 4.1 

Table 4) Prerequisites for VSC 4.1. 

Prerequisites 

 VMware vSphere/ESXi servers must be set up. VSC 4.1 supports ESX 3.5, ESX, or ESXi 4.0 and 4.1, 
and ESX or ESXi 5.x. 

 VMware vCenter must be installed and configured to manage vSphere Servers. Since vCenter sends 
commands to and controls the ESXi hosts, it must be at the same or a later version for the ESXi host 
to recognize and control the added capabilities of the new host version. 

 A Windows
®
 host machine must be prepared. For installation requirements, refer to the Virtual 

Storage Console 4.1 for VMware vSphere Installation and Administration Guide. 

 A network connection must exist between the Windows computer running the Virtual Storage Console 
(VSC) and the management ports of the storage controllers (including vFiler units when using 
MultiStore or management LIF on the Storage Virtual Machine), the vSphere and ESXi hosts, and the 
vCenter Server. 

 The TCP ports 8043 and 8143 must be open on the Windows server that is hosting VSC. 

 Upon completion of the VSC installation, the vSphere Client must be closed and restarted for the 
VSC plug-in to be displayed. 

 Appropriate licenses are required for the VSC plug-in modules and supporting Data ONTAP features. 
These are listed in the Virtual Storage Console 4.1 for VMware vSphere Installation and 
Administration Guide. 

http://support.netapp.com/documentation/productlibrary/index.html?productID=30048
http://support.netapp.com/documentation/productlibrary/index.html?productID=30048
http://support.netapp.com/documentation/productlibrary/index.html?productID=30048
http://support.netapp.com/documentation/productlibrary/index.html?productID=30048
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Prerequisites 

 Any preexisting version of SnapManager for Virtual Infrastructure (SMVI) must have been removed 
from the server on which VSC will be installed. 

 VSC 4.1 System Requirements 5.1

The VSC 4.1 system has the following requirements: 

 A Windows 32-bit or 64-bit computer 

 1GB RAM (minimum), 2GB RAM (recommended) for a 32-bit system 

 2GB RAM (minimum), 4GB RAM (recommended) for a 64-bit system 

 Installation on a local disk of the Windows computer, not on a network share 

 A network connected between the Windows computer running VSC 4.1 and the management ports of 
the storage controllers, the ESXi hosts, and the vCenter Server 

 A display set to 1,280 x 1,024 pixels to view VSC 4.1 pages correctly 

vSphere Client Configuration 

The client computer that runs the VMware vSphere Client software must have Microsoft Internet Explorer 

8 or later installed. 

VSC 4.1 Preinstallation Considerations 

Upgrades are possible on systems running VSC 2.0 or later. For releases earlier than VSC 2.0 or for a 

standalone version of Rapid Cloning Utility (RCU) or SMVI, those software versions must be uninstalled 

before VSC 4.1 is installed. If the VSC 4.1 installer detects any of these software packages, it issues a 

prompt to uninstall them and stops the installation of VSC 4.1. 

By default, the VSC installer installs the following three capabilities: 

 Monitoring and host configuration 

 Provisioning and cloning 

 Optimization and migration 

An option is also available to install the backup and recovery capability. This requires purchasing a 

license for SMVI. Other licenses may be required, depending on which capabilities are used. 

The following licenses are required on storage systems running Data ONTAP 7.3.x: 

 Protocol licenses (NFS, FCP, iSCSI) 

 FlexClone (for provisioning and cloning, backup and recovery) 

 SnapRestore (for backup and recovery) 

 A-SIS (for managing deduplication through provisioning and cloning) 

 MultiStore (for managing multi-tenant infrastructures with vFiler units) 

 SMVI (for backup and recovery) 

The following licenses are required on storage systems running clustered Data ONTAP: 

 Protocol licenses (NFS, FCP, iSCSI) 

 FlexClone (for provisioning and cloning only) 

 SnapRestore (for backup and recovery) 

 SnapManager suite 

The following licenses are required on storage systems running Data ONTAP 8.x operating in 7-Mode: 
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 Protocol licenses (NFS, FCP, iSCSI) 

 FlexClone (for provisioning and cloning only) 

 A-SIS (for managing deduplication in provisioning and cloning) 

 SnapRestore (for backup and recovery) 

 MultiStore (for managing multi-tenant infrastructures with vFiler units) 

 SMVI (for backup and recovery) 

 The FlexClone license is not required for backup and recovery for Data ONTAP 8.1 or later in Note:
7-Mode. 

 Install VSC 4.1 5.2

To install the VSC 4.1 software, complete the following steps: 

1. Download the Virtual Storage Console 4.1 from the NetApp Support site. 

 The VSC can be installed on the vCenter Server or on a standalone Windows installation. For Note:
example, a standalone installation would be used for running the vCenter 5 virtual appliance.  

2. To install the VSC plug-in, double-click the file downloaded in step 1. 

3. On the Installation wizard Welcome page, click Next. 

4. Read the license agreement and click Accept. Click Next. 

5. Select the backup and recovery capability. Click Next. 

 The backup and recovery capability requires an additional license. Note:

 

6. Select the location where VSC will be installed. Click Next. 

http://support.netapp.com/NOW/cgi-bin/software/?product=Virtual+Storage+Console&platform=VMware+vSphere
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7. Make a note of the registration URL. This URL is needed to register the VSC plug-in with the vCenter 
Server after the installation. Click Install. 

 

Register VSC with vCenter Server 

To register the VSC with the vCenter Server, complete the following steps: 

1. Open a web browser. 

 A browser window with the registration URL opens automatically when the installation phase Note:
is complete. However, some browser settings may interfere with this function. If the browser 
window does not open automatically, open a browser window manually and enter the URL. 
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2. When the browser is running on the computer where VSC is installed, enter the URL provided by the 

installation wizard (https://localhost:8143/Register.html). Otherwise, replace localhost with 

the host name or IP address of the VSC server. 

3. In the Plugin service information pane, select the IP address that the vCenter Server uses to access 
the VSC server from the drop-down list. 

4. In the vCenter Server Information pane, enter the host name or IP address, port, user name, and user 
password. Click Register to complete the registration. 

 

Discover and Add Storage Resources 

To discover storage resources for Virtual Storage Console, complete the following steps: 

1. Using the vSphere Client, log in to the vCenter Server. 

2. Click Yes when the security certificate warning is displayed. To view the certificate, click View 
Certificate. 
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3. Click the Home tab in the left side of the vSphere Client window. 

4. Under Solutions and Applications, click the NetApp icon. 
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5. In the navigation pane, select Monitoring and Host Configuration if it is not selected by default. 

 

6. If the discovery process does not start automatically, click Update. 

 The automatic discovery process applies to the monitoring and host configuration capability, Note:
and to the provisioning and cloning capability. Storage controllers must also be manually 
added to the backup and recovery capability. 

7. Add the storage controller credentials. Two scenarios are possible: 

a. Some storage is already mapped to vSphere hosts. 

b. No storage is mapped to the vSphere hosts. 

 For storage systems running Data ONTAP 7.x or 8.x in 7-Mode, use the credentials of a Note:
storage controller user. For storage systems running clustered Data ONTAP 8.1 or later 
clustered releases, the credentials of both the Vserver user and Cluster user must be 
entered. 

8. After the update is complete, no controllers are listed in the Storage Controllers pane if the storage in 
the NetApp storage controllers is not mapped to ESXi hosts. 

9. Click Add to add credentials for the storage controller. 

 VMware vSphere 5 Thin Provisioning Using VSC 5.3

To provision either NFS datastores or VMFS datastores by using the VSC, complete the following steps: 

1. In the left pane of vCenter Server, select the cluster or host in which to add a new datastore. 
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2. Right-click the host or cluster, and select NetApp > Provisioning and Cloning > Provision datastore. 

 

3. Select a target storage controller from which you want to provision storage. In this example, a storage 
controller running clustered Data ONTAP is selected. 

 

 This dynamic wizard page adjusts automatically depending on whether a storage controller Note:
running clustered Data ONTAP or a 7-Mode controller is selected.  

4. If a storage controller running clustered Data ONTAP is selected, a vServer must also be selected to 
provision the datastore. Select a vServer. Click Next. 
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5. Select whether to provision an NFS datastore (volume) or a VMFS datastore (LUN). Click Next. 

 

 To provision FCP-based LUNs, the controller must be properly licensed. Proper zoning must Note:
be in place for the vServer and the storage controller to be able to communicate with 
vCenter. 

6. Specify the details for the new datastore. 
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a. Select the size of the datastore. 

b. Enter the name of the datastore. 

c. Select the appropriate aggregate. 

d. Select the Thin provision checkbox. 

e. Optional: Select the Auto-grow checkbox. 

 Set the Autogrow policies when creating the datastore to reduce the likelihood of the volume Note:
filling up and reaching an out-of-space condition. NetApp considers this as a best practice. 

f. Optional: Select the grow increment and the maximum datastore size. 

g. Click Next. 

 

 The warning displayed at the bottom of this wizard page is specific to VMFS datastores. Note:
When a LUN is first created, its geometry is set based on its initial size. LUN geometry refers 
to the number of heads, number of cylinders, sectors per cylinder, and bytes per sector 
(values required by SCSI). When you enlarge a LUN, some (but not all) of these values can 
be increased and eventually a limit is reached.  

For example, if you create a 1GB LUN, then its geometry is constrained by this small size. Later on, if you 

try to grow this LUN to over 1TB, then you will need to increase one of the geometry parameters beyond 

the SCSI limit. Had you created a 500GB LUN to begin with, the initial geometry would have been 

different, and you would be able to grow the LUN to 1TB. This constraint is not specific to any particular 

storage array; it is an artifact of how the SCSI protocol works when it specifies the head, cylinder, and 

sector values. For more information, refer to KB 3012229. 

7. Review the settings for accuracy. Click Apply. 

https://kb.netapp.com/support/index?page=content&id=3012229
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8. After you click Apply, the VSC does the following: 

a. Refreshes the storage connection.  

b. Creates a volume on the storage.  

c. Creates the appropriate export rules based on the cluster or host that you selected for adding the 
volume.  

d. Mounts this new volume to all hosts within the cluster. 

 

 This is one of the best efficiency features of the VSC and is the most often overlooked tool Note:
that you have at your disposal. The VSC has the ability to create and provision a datastore 
for up to 32 hosts at the same time by using this simple process. 
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6 NetApp NFS Plug-In 1.0 for VMware VAAI 

 Enable the VAAI for NFS 6.1

To enable VMware vStorage for NFS when using clustered Data ONTAP, complete the following steps: 

1. From an SSH session to the storage cluster management address, log in with the administrative user 
name and password.  

2. Enable vStorage on the Vservers. 

vserver nfs modify –vserver vcloud_vserver01 -vstorage enabled 

vserver nfs modify –vserver vcloud_vserver02 -vstorage enabled 

3. Verify that the export policy rules are set up correctly. 

vserver export-policy rule show –vserver vcloud_vserver01 

vserver export-policy rule show –vserver vcloud_vserver02 

4. The access protocol for the policy name should be NFS. If the access protocol is not NFS for a given 
rule index, run the following command to set NFS as the access protocol:  

vserver export-policy rule modify –vserver vcloud_vserver01 –policyname default –ruleindex 

<var_rule_index> -protocol nfs 

vserver export-policy rule modify –vserver vcloud_vserver02 –policyname default –ruleindex 

<var_rule_index> -protocol nfs 

 Install NetApp NFS Plug-In for VMware VAAI  6.2

To install the NetApp NFS plug-in for VMware vStorage APIs for Array Integration (VAAI), complete the 

following steps:  

1. From the vSphere console of the VSC virtual machine (VM), go to the Software Downloads page in 
the NetApp Support site. 

2. Scroll down to locate the NetApp NFS Plug-in for VMware VAAI, select the ESXi platform, and then 
click Go. 

3. Download the .vib file of the most recent plug-in version. 

4. Verify that the file name of the .vib file matches the predefined name that VSC 4.1 for VMware 

vSphere uses: NetAppNasPlugin.vib. 

 If the .vib file name does not match the predefined name, rename the .vib file. Neither the Note:
VSC client nor the NetApp vSphere Plug-in Framework (NVPF) service needs to be restarted 
after the .vib file is renamed. 

5. Copy the plug-in .vib file (NetAppNasPlugin.vib)to C:\Program Files\Virtual Storage 

Console\etc\vsc\web. 

 The default directory path is C:\Program Files\NetApp\Virtual Storage Console\. Note:
However, VSC 4.1 for VMware vSphere lets you change this directory. For example, if you 
are using the default installation directory, the path to the NetAppNasPlugin.vib file is the 
following: C:\Program Files\Virtual Storage 
Console\etc\vsc\web\NetAppNasPlugin.vib. 

6. In the VMware vSphere Client connected to the vCenter Server, select Home > Solutions and 
Applications > NetApp.  

7. In the Monitoring and Host Configuration capability navigation pane, select Tools.  

8. Under NFS Plug-in for VMware VAAI, click Install on Host. 

http://support.netapp.com/NOW/cgi-bin/software/
http://support.netapp.com/


60 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

 

9. In the dialog box, select all ESXi hosts and click Install, and then click Yes. 

 The monitoring and host configuration capability automatically installs the plug-in on the hosts Note:
selected. 
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10. Select Home > Inventory > Host and Clusters.  

11. For each host (one at a time), right-click the host and select Enter Maintenance Mode. 
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12. Click Yes, click Yes again, and then click OK. 

 It may be necessary to migrate all VMs away from the host. Note:

13. Once the host is in maintenance mode, right-click the host, and then select Reboot.  

14. Enter a reason for the reboot and click OK. 

15. After the host reconnects to the vCenter Server, right-click the host, and then select Exit Maintenance 
Mode. 

16. Make sure that all ESXi hosts get rebooted. 

7 VMware vCloud Director 5.1 Setup 

 Install vCloud Director 5.1 7.1

Table 5) Prerequisites for VMware vCloud Director 5.1. 

 Prerequisites 

 VMware ESX/ESXi version 4.1 and later must be installed.  

 vCenter Server 5.0 and later must be installed. 

For information on interoperability between VMware products or between database versions and vCenter, 
refer to the VMware Product Interoperability Matrixes webpage. 

http://partnerweb.vmware.com/comp_guide/sim/interop_matrix.php
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Install vCloud Director 5.1 

For directions on how to install a new instance of vCloud Director 5.1 or how to upgrade from earlier 

versions, refer to the VMware vCloud Director Installation and Upgrade Guide. 

Note: Follow all VMware best practices and recommendations for installation. 

 VMware vCloud Director 5.1 vShield Manager 7.2

VMware vCloud Networking and Security is a leading software-defined networking and security solution 

that incorporates vShield Manager, a centralized access point for managing, deploying, reporting, 

logging, and integrating third-party security services. 

Install vShield Manager 

To install vShield Manager, complete the following steps: 

1. Download VMware vCloud Networking and Security. 

2. Log in to vCenter. 

3. From the File menu, select Deploy OVF Template. 

 

4. Browse to the location of the OVA template file and select the file. Click Next. 

http://pubs.vmware.com/vcd-51/topic/com.vmware.ICbase/PDF/vcd_51_install.pdf
http://www.vmware.com/products/datacenter-virtualization/vcloud-network-security/overview.html
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5. Review the OVF Template Details, and click Next. 
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6. Read and accept the license agreement. Click Next. 

 

7. Specify a template name and location. Click Next. 
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8. Select the host or cluster on which the deployed OVA template needs to be run, and click Next. 
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9. Select the resource pool for the template. Click Next.  

 

10. Select the destination storage for the virtual machine (VM) files. Click Next. 
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11. Select a disk format and review the settings. Click Next. 
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12. Select the Power on after deployment checkbox to power on the template after deployment and click 
Finish. 

 

13. Verify that the newly created machine is visible in vCenter Client. 

 

14. Log in to the console with the user name admin and the password default. 
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EXT3—fs (sdal): Mounted filesystem with writeback data mode  

journald starting. CoMMit interval 5 seconds 

EXT3—fs (sda3): Mounted filesysteM with writeback 

/etc/rc.d/init.d/rc: End /etc/rc.d/rc3.d/S9Olocal start 

[ 55.525532] el000: MgMt NIC Link is Up 1000 Mbps Full Duplex, Flow Control: N 

one 

manager login: admin 

Password: 

15. At the vShield Manager prompt, complete the following steps: 

a. Run the enable command.  

b. Provide the password default.  

c. Run the setup command to configure an IP address and a default gateway DNS for the machine.  

d. Exit and log back in again. 

e. Run the show interface command to verify that the interface is up and running. 

EXT3—fs (sda3): Mounted filesysteM with writeback data Mode 

d/rc: End /etc/rc. d/rc3. d/SSOlocal start 

[ 66.525532] el000: MgMt NIC Link is lip 1000 Mbps Full Duplex, Flow Control: N 

one 

manager login:admin 

Password: 

Manager> enable 

Password: 

Manager> setup 

Use CTPL—D to abort configuration dialog at any prompt. 

Default settings are in square brackets ‘[]‘. 

IP Address (A.B.C.D): 192.168.200.94 

Subnet Mask (A.B.G.D): 255.255.255.0 

Default gateway (A.B.C.D): 192.160.200.1 

Primary DM3 IP (A.B.C.D): 192.168.200.1 

Secondary DNS IP (A.B.C.D): 192.160.200.2 

DM3 domain search list (space separated): rtp.netapp.com 

Old configuration will be lost 

Do you want to save new configuration (y/[n]): y_ 

Please logout and login back again  

Manager> exit 

Manager login: admin 

Password: 

Manager> show interface 

Interface MgMt is up, line protocol is up 

index 2 Metric 1 Mtu 1500 <IJP,BPOADCAST,IIIJNNING,MULTICAST> 

HWaddr: HH:5H:55:ae:3d:af 

met 192. 150.200.94/24 broadcast 192. 150.200.255 

Auto—duplex (Full), Auto—speed (l000Mb/s) 

input packets 550, bytes 39055, dropped 0, Multicast packets O 

input errors O, length O, overrun O, 0110 0, fraMe O, fifo O, Missed O 

output packets 21, bytes 3490, dropped O 

output errors 0, aborted 0, carrier 0, fifo O, heartbeat 0, window H 

collisions H 

Manager> 

16. Open the VMware vShield Manager login from the browser, using the default IP address. Log in with 
the default user name and password. 
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17. Click Edit to register the vCenter Server in vShield Manager.  

 

18. Specify the vCenter Server IP address, user name, and password and click OK to register to the 
vCenter Server. 
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19. Verify that the vCenter Server resources are listed in vShield Manager and then click Install to add 
options such as vShield App, vShield Endpoint, and vShield Data Security.  

 

20. Select the checkbox for each application to be installed, and then click Install installing the VM. 
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21. Verify that the correct versions of the services are installed. 

 The services can be uninstalled by clicking Uninstall.  Note:

 

22. The newly created vShield Manager and the machine vShield-FW-192.168.200.105, which was 
installed during vShield vApp installation, are now visible in the vCenter inventory.  
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 For additional information about configuring vShield services such as vShield Edge, vShield Note:
App, vShield Data Security, and VXLAN, refer to the vShield Installation and Upgrade Guide 
and to the VMware vCloud Networking and Security webpage. 

 VMware vCloud Director 5.1 Storage 7.3

Create User-Defined Storage Profile 

To create a user-defined storage profile, complete the following steps: 

1. In the VM Storage Profiles window, click Enable VM Storage Profiles. 

 

2. In the Enable VM Storage Profiles window, click Enable and click Close. 

http://www.vmware.com/pdf/vshield_512_quickstart.pdf
http://www.vmware.com/products/datacenter-virtualization/vcloud-network-security/features.html
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 If the option is greyed out the profile is already enabled. Note:

3. In the VM Storage Profiles window, click Manage Storage Capabilities. 

 

4. In the Manage Storage Capabilities window, click Add. In the Add Storage Capability dialog box, 
enter the name, provide a short description, and click OK. 
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5. Verify that the newly created storage capability is displayed, and click Close. 

 

6. In the VM Storage Profiles window, click Create VM Storage Profile. 
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7. Enter a name and a description for the new storage profile. Click Next. 

 

8. Select the appropriate storage capability and click Next. On the page that follows, click Finish. 
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9. Verify that the newly created storage profile is displayed. 

 

10. To assign this profile to a datastore (or a set of datastores), on the Home tab, select Inventory and 
then click Datastores and Datastore Clusters. Right-click the datastore to which you want to assign 
the new storage profile and select Assign User-Defined Storage Capability. 
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11. Select the storage capability for this datastore from the drop-down list. Click OK. 

 

12. In the Datastores and Datastore Clusters window, the User-Defined Storage Capability displays the 
capability assigned to this datastore. This capability is mapped to the storage profile that was created 
earlier and is now mapped to the datastore. This links the datastore and the profile together. 
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 VMware vCloud Director 5.1 Provider 7.4

For vCloud Director hosts can be divided into either resource pools or clusters and presented to vCloud 

for use. For the purposes of this document we will be using resource pools. Either method can be used. 

Create Resource Pools 

VMware vSphere ESXi hosts provide the compute power for vCloud Director. VSphere hosts are placed 

in groups of resources, such as clusters or resource pools. 

To create resource pools, complete the following steps: 

1. Log in to the vSphere Client with appropriate credentials. 

 

2. Right-click the cluster and select New Resource Pool. 

 

3. Enter the resource pool name and use the slider bars to change the default values. Click OK to 
confirm the settings. 
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4. Verify that the newly created resource pool is visible in the vCenter Server. 

 

5. Verify that the newly created resource pool is available for use. 
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Create Provider vDC 

To create a provider virtual data center (vDC), complete the following steps: 

1. Log in to vCloud Director with the administrator user ID and password. 

 

2. From the vCloud Director home page, select Create another Provider VDC to create a new provider 
vDC. 
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3. Enter the name of the new provider vDC and an optional description. 

4. Select the checkbox to enable the provider vDC and select the hardware version to be used in the 
organization vDC based on the provider vDC. Click Next. 

 If the provider vDC is not enabled, its compute and storage resources cannot be used for the Note:
creation of organization vDCs. 

 

5. From the available resource pool list, select the resource pool that will present compute and storage 
to the provider vDC. 

6. Click Next to select the storage supplied by the provider vDC. 
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7. In vCloud Director 5.1, all storage is represented as a storage profile. Select from the available 
storage profiles and click Add Storage to add the selected profile. Click Next. 

 

8. To enable vCloud Director to install an agent on each of the hosts, specify the root login credentials 
for the ESXi hosts that are part of the selected cluster. Click Next. 
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9. Review the settings and click Finish. 

 

Add Storage Profile to Provider vDC 

To add a storage profile to the provider virtual data center (vDC), complete the following steps: 

1. In vCloud Director, select Manage & Monitor > Cloud Resources > Provider VDCs from the left pane. 
From the drop-down list of provider vDCs, select the Provider VDC you created. 

2. Click the Storage Profiles tab, click Actions, and then click Add Storage Profile. 
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3. Add a storage profile and its associated datastores to the provider vDC. Select the storage profile 
from the list and click Add. 

 

4. Verify that the newly created storage profile is displayed in the provider vDC. 
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 VMware vCloud Director 5.1 Network Pools Isolation-Backed 7.5

Create Isolation-Backed Network Pool 

In this example environment, we will create an Isolation-Backed Network Pool. To create an isolation-

backed network pool, complete the following steps: 

1. From the vCloud Director home page, select Create another network pool. 

 

2. In the left pane, select Network Pool Type and then select the Network Isolation-Backed option. Click 
Next. 
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3. To configure the isolation-backed pool, enter the number of vCD isolated networks and the VLAN ID 
and then select the appropriate vNetwork Distributed Switches. Click Next. 

 

4. Specify a name for the network pool and provide an optional description. Click Next. 
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5. Verify the settings and click Finish to complete the setup. 

 

6. Click the Manage & Monitor tab, and in the left pane, select Network Pools to review the newly 
created network pool. 
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 VMware vCloud Director 5.1 Organization 7.6

Create New Organization 

To create a new organization, complete the following steps: 

1. From the vCloud Director home page, select option 5, Create another organization. 

 

2. Enter the organization name, the organization full name, and a short description. Click Next. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Define a lightweight directory access protocol (LDAP) service to use for this organization by selecting 
LDAP Options. Select from the available LDAP options, and click Next. 
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4. In the New Organization window, click Add Local Users. Click Add to enter local users for this 
organization. 

 

5. In the New User window, complete the following steps and click OK: 

a. Enter a user name. 

b. Enter a password; reenter it to confirm it. 

c. Select the checkbox to enable this user’s credentials. 
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d. Select a role for this user from the drop-down list. 

 

6. To share catalogs with other organizations, select Catalog Publishing. Select from the options 
available, and click Next. 



93 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

 

7. To configure Simple Mail Transfer Protocol (SMTP) settings for this organization, select Email 
Preferences. Enter the required information, and click Next. 

 

8. To configure policies for the organization, click Policies. Here, you can define quotas for resources 
available to the organization, specify the lease period for the resources, and set password policies 
and limits for various activities. Click Next to continue. 
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9. To view the summary of specifications for this organization, click Ready to Complete. Review the 
settings, and click Finish to create the organization. 

 

10. View the new organization under the Manage & Monitor option on the home page. 
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Allocate Organization Resources 

Allocating resources to an organization involves making resources from the provider virtual data center 

(vDC) available to an organization vDC that is associated with a particular organization. 

To create a new organization vDC, complete the following steps: 

1. From the vCloud Director home page, select option 6, Allocate more resources to an organization. 

 

2. Select an organization to allocate more resources. Click Next. 
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3. Select the provider vDC from which the organization vDC will draw its resources. Click Next. 

 

4. Select an allocation model to use for this organization vDC. The three methods for controlling the 
quality of service and the costs associated with using the resources are the allocation pool model, the 
pay-as-you-go model, and the reservation pool model. Choose the pay-as-you-go model. 
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5. Configure the allocation model and allocate storage to the organization vDC according to the 
allocation model selected: 

 Pay as you go. Resources are committed only when vApps are created in the organization vDC. 
The system administrator controls over commitment of capacity on the subsequent pages. When 
backed by a provider vDC that has multiple resource pools, compute resources are elastic. 

 For more information on allocating resources to an organization, refer to the VMware vCloud Note:
5.1 Documentation Center. 

http://pubs.vmware.com/vcd-51/index.jsp?topic=%2Fcom.vmware.vcloud.api.doc_51%2FGUID-6DA11728-5405-4554-BEFD-81E8F4D80161.html
http://pubs.vmware.com/vcd-51/index.jsp?topic=%2Fcom.vmware.vcloud.api.doc_51%2FGUID-6DA11728-5405-4554-BEFD-81E8F4D80161.html
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6. After selecting and configuring the Pay-as-You-Go model and allocating storage to the organization 
vDC, select Enable Thin Provisioning and Enable Fast Provisioning in order to use these features. 
Click Next. 
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7. To select the network pool and the third-party services available to this organization vDC, click Select 
Network Pool & Services and enter the required information. Click Next. 

 

8. To create an edge gateway for this organization, complete the following steps and click Next: 

a. Select Configure Edge Gateway from the panel on the left. 

b. Check Create a New Edge Gateway. The configuration options for the edge gateway are 
displayed. 

c. Provide a name for the edge gateway and select a configuration model. 

 There is no difference in the security functions offered by the full versus the compact Note:
configuration models. The full configuration model provides better performance and capacity, 
whereas the compact configuration model uses less memory and compute resources. 

d. Configure IP settings and enable external IP settings. 

e. Click the Sub-Allocate IP Pools checkbox and allocate a set of IPs used by edge gateway 
services. 

Refer to the vCloud Administrator’s Guide for detailed provisioning steps. 

http://pubs.vmware.com/vcd-51/topic/com.vmware.ICbase/PDF/vcd_51_admin_guide.pdf
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9. Select the external networks to which the new edge gateway can connect, and click Next. 

 If the network you want to connect to is not listed, a new network must be created. To create Note:
a new network, click create a new external network. 
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10. To create an organization vDC network, complete the following steps and click Next: 

a. Click the Create Organization vDC Network tab. 

b. Enter the name of the network, the gateway address, and the netmask to be used. 

c. Define the DNS suffix, if required, and a static network pool to be used for this network. 
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11. Enter the name and description of the new organization VDC. 
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12. To view the summary of specifications for this organization VDC, click Ready to Complete. Review 
the settings and click Finish to create the organization VDC. 

 

 Setup Catalogs and vApps 7.7

After organizations are created, content catalogs must be created that can be readily used by members of 

the organizations. 

Create Catalog 

To create a catalog, complete the following steps: 

1. To create a catalog, select option 7, Add a catalog to an organization, on the home page. 
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2. Select the organization that will use the catalog and click Next. 

 

3. Enter the name and description of the catalog and click Next. 

 

4. Select the Publish this Catalog option from the panel on the left. Select whether or not to share this 
catalog with other organizations. Keep the default option selected to restrict the use of this catalog to 
only the organization for which it was originally configured. Click Next. 
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5. To view the summary of specifications for this catalog, click Ready to Complete. Review the settings 
and click Finish to create the catalog. 

 

6. Click Manage & Monitor, tab in the vCloud Director System page. Select Organizations. Access an 
organization by selecting it from the list. 
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7. Note that the organization’s name is displayed in the new tab opened by vCloud Director. 

 

8. Click Catalogs, located at the top of the page, to access the catalogs available to this organization. 

 

Create vApp 

A vApp is a collection of one or more virtual machines that run within an organization. To create a new 

vApp, complete the following steps: 

9. On the home page for the organization, click Build New vApp. 
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10. Enter the name for the new vApp, and click Next. 

 

11. Select Add Virtual Machines and click New Virtual Machine. 

 A vCloud administrator can select an existing virtual machine template from a catalog to use Note:
with this vApp or add a new, blank virtual machine. 
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12. Enter the required details in the New Virtual Machine dialog box. Click OK to close this window, and 
click Next. 
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13. Select Configure Resources. Enter the virtual machine name and the storage profile that it will use 
and click Next. 
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14. Select Configure Virtual Machines. Define the network rail to attach the NIC of the virtual machine 
and click Next. 
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15. Select Configure Networking to configure the network settings for the vApp. Select the Fence vApp 
checkbox, and click Next. 

 This enables multiple virtual machines in various vApps to be powered on without conflict by Note:
isolating their IP and MAC addresses. 

 

16. Review and click Finish to complete the setup. To view the summary of specifications for this vApp 
configuration, click Ready to Complete. Review the settings and click Finish to create the vApp. 
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17. From the organization home page, click Start to start a vApp, or click the thumbnail for a vApp that is 
already powered on. A graphical representation of the vApp network configuration is displayed. 

 

18. Note that the organization’s tab, under My Cloud, displays a graphical representation of the vApp 
network configuration. 
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19. Right-click the vApp and select Insert CD/DVD from Catalog. 

 

20. Select from the available ISOs on the media, and click Insert. 
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21. Select vApps from the panel on the left to list available vApps. 

 

22. Right-click the vApp and select Add to Catalog. 

 

23. Enter the required information and click OK. 
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24. From the organization home page, click Catalog to view the status of the vApp. The vApp should now 
be ready to use. 

 

8 Snap Creator Setup 

 Snap Creator 4.0 Preinstallation 8.1

Download NetApp Snap Creator Framework 

To download the NetApp Snap Creator Framework, complete the following steps: 

1. Go to the Software page at the NetApp Support site. Snap Creator is listed in the Software Download 
section as Snap Creator Framework. 

2. Select a platform and click Go. 

3. Click View and Download to select the desired version of Snap Creator Framework. 

4. At the bottom of the page, in the Software Download Instructions section, click Continue. 

5. Read and accept the end user license agreement. 

6. Select the operating system and bit level of the software packages to be downloaded. 

 The link to the NetApp Snap Creator Framework Installation and Administration Guide for the Note:
version of software selected should be included on the download page. 

http://support.netapp.com/NOW/cgi-bin/software
http://support.netapp.com/
https://communities.netapp.com/servlet/JiveServlet/previewBody/27270-102-1-46865/SC_4.1_IAG.pdf


116 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

Create Data ONTAP User for Snap Creator 

Depending on the version of Data ONTAP being used on the storage controllers, one of the following two 

procedures must be performed on each storage controller. 

Clustered Data ONTAP  

Clustered Data ONTAP requires the creation of two users on the clustered system: a cluster user and a 

Virtual Storage Server (Vserver) user. Both sets of users require the HTTP, ONTAPI, and SSH 

applications. The cluster user uses the admin role, and the Vserver user uses the vsadmin role. 

The two users cannot be interchanged. For example, the cluster user does not have access to the APIs 

that are required to perform certain actions such as creating a Snapshot copy. This is true even if you use 

the default cluster admin account. Vserver accounts with the vsadmin role must be used for Snap Creator 

to work properly.  

To create a clustered Data ONTAP user for Snap Creator by using Data ONTAP CLI (SSH, console 

connection, or Telnet), complete the following steps: 

1. Create the user vcloud on the vcloud_vserver01 Vserver and allow ONTAPI and SSH, which are 
required for Snap Creator. 

security login create -username vcloud -vserver vcloud_vserver01 -application http -authmethod 

password -role vsadmin  

  

Please enter a password for user vcloud: <<your password>> 

Please enter it again: <<your password>> 

  

security login create -username vcloud -vserver vcloud_vserver01 -application ontapi -authmethod 

password -role vsadmin  

security login create -username vcloud -vserver vcloud_vserver01 -application ssh -authmethod 

password -role vsadmin 

2. Create a cluster user using the same commands that were used to create the Vserver user, but in 
place of the Vserver name, use the cluster name. All other commands are identical. 

security login create -username vcloud -vserver vcloud_cluster -application http -authmethod 

password -role admin 

  

Please enter a password for user: <<your password>> 

Please enter it again: <<your password>> 

  

security login create -username vcloud -vserver vcloud_cluster -application ontapi -authmethod 

password -role admin 

security login create -username vcloud -vserver vcloud_cluster -application ssh -authmethod 

password -role admin 

Note: These steps must be performed once on each Vserver and cluster where Snap Creator is used. 

Verify Java Version on Snap Creator Hosts 

To verify the Java version on the Snap Creator server or agent host, complete the following steps: 

1. Run the following command: 

java –version 

2. JRE 1.6 or higher version must be installed on the Snap Creator server. The version of Java installed 
must match the version of Snap Creator installed. For example, when using a 64-bit operating system 
with a 64-bit version of Snap Creator installed, a 64-bit version of Java must be used. If necessary, 
download Java from the Java Downloads for All Operating Systems page. 

http://www.java.com/en/download/manual.jsp
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Table 6) Prerequisites for Snap Creator 4.0 Server Windows. 

 Prerequisite 

The person performing the installation must have sufficient access and privileges to perform the installation. 

 Install Snap Creator Server 8.2

Note: NetApp recommends using netstat or a similar tool to verify that the ports that Snap Creator uses 
are not already in use. The default port for the Snap Creator server is 8080, and the default port 
for the Snap Creator agent is 9090.  

To install the Snap Creator server on Windows, complete the following steps: 

1. If an earlier version of Snap Creator is already installed, do the following: 

a. Back up all logs and configuration files. 

b. To save schedules and roll-based access control users and roles, back up the Snap Creator 
database folder located at /path/to/scServer##/snapcreator (Snap Creator 3.x) or 

/path/to/scServer##/engine/snapcreator (Snap Creator 4.0). 

 This procedure assumes that this is the first time Snap Creator has been installed. If an Note:
earlier version of Snap Creator is already installed, a prompt is displayed to indicate that the 
earlier version will be uninstalled before proceeding. 

2. Double-click Snap_Creator_Framework_Community_Release_4.0.0c-WindowsXX.exe file to launch 

the Snap Creator installer. 

3. On the Welcome page, click Next to start the installation. 

 

4. Read and accept the terms of the license agreement. 
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5. On the Choose Install Type page, change the following settings to fit various installation types and 
click Next: 

a. Select Server as the installation type. 

 Both the server and the agent can be installed at the same time if it is desired to have them Note:
both on the same system.  

b. Select Start Agent as a Service. 

 If Start Agent as a Service is not selected, the Port Number field will be disabled. Note:

c. Accept the default port of 8080 or specify the desired port number. 

 NetApp recommends using netstat or a similar tool to verify that the network port (8080, by Note:
default) is not already in use. 
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6. Configure the Profile Setup page and click Next: 

 The information entered on the Profile Setup page is used to set up the profile required for Note:
the Snap Creator GUI. 

a. Controller Serial Number: This parameter is optional. Enter the serial number of the storage 
system. When this information is provided, the controller serial number is included in support and 
log outputs. This information can be used to help troubleshoot any issues that happen in the 
future. 

b. GUI User Name: Enter the name of the GUI user. 

c. GUI Password: Enter the password for the GUI user. 

d. GUI Confirm Password: Reenter the password for the GUI user. 

e. Enable Job Monitor: Select this option to enable Job Monitor. Job Monitor is a separate section in 
the GUI that monitors all of the jobs that are run by Snap Creator and the status of these jobs. 

f. Job Log Size: Enter the number of jobs to keep in the history of the job log. The default is 100 
jobs. 
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7. The Choose Install Location page allows customization of the Snap Creator installation path. Select 

the destination folder, and click Next. The default destination folder is C:\Program 

Files\NetApp\Snap_Creator_Framework. 

 

8. On the Choose Start Menu Folder page, customize the folder in which Snap Creator should appear in 
the Windows Start Menu and click Install. Although Snap Creator is the default folder, it can be 
customized, if desired. 
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9. After the installation completes, click Next. 

 

10. During the Snap Creator service installation, a command prompt is displayed if a service was 
selected as part of the installation options. This process attempts to start existing services; therefore, 
it is common to see failure messages listed as part of this step. 
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11. Click Finish to close the Windows installer. 

12. Validate the Snap Creator Framework GUI startup by navigating to the local host on port 8080 or to 
whatever port was specified for the server during installation process. 

 

Encrypt Snap Creator Users Password 

To encrypt the Snap Creator user password, complete the following step: 

1. Create an encrypted password for any user by using the --cryptpasswd command and typing the 

password that was used for the account. This step prevents a plain text password from being inserted 
into a configuration file on the host on which Snap Creator is installed. 

snapcreator.exe --cryptpasswd 

Please Enter Password:  

Your encrypted password is: 53616c7465645f5f614d4964d340f7f2d26eef38f443f5ea9c2f8020015a2dfa 

 Snap Creator 4.0 Plug-In for VMware vCloud Director 8.3

Create Configuration File for vCloud Director by Using GUI 

Snap Creator features an easy-to-use GUI that includes a wizard to simplify the process of creating a 

configuration file. To create a configuration file through the GUI, complete the following steps: 

 The variables in this provisioning procedure are provided as an example. When creating a Note:
configuration file, always verify that the settings are correct for the specific environment. 

1. Open the Snap Creator GUI from a web browser by navigating to http://<hostname or IP>:<port>. 

A configuration file can also be created with a text editor, but NetApp recommends generating 
configuration files through the GUI so that parameters can be validated as they are entered. 

2. In the Profiles and Configurations window, click Add Profile. 

 The first time the Snap Creator GUI is opened, a welcome message is displayed, followed by Note:
prompts directing the user to create a profile and a new configuration. 
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3. In the dialog box requesting the name of the new profile, click OK. 

 In this example, the profile is named vcloud_backups. Note:

 

4. Verify that the new profile is listed in the Profiles and Configurations pane. Right-click the profile and 
select New Configuration to create a new configuration file. 

 

5. On the Snap Creator Framework configuration wizard Welcome page, click Next. 
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6. Enter a configuration name and click Next. 

 The option for enabling password encryption is selected by default to prevent passwords from Note:
being displayed in clear text in the configuration. 

 In this example, the selected configuration name is vapp_backup. Note:

 

 The wizard displays a tool tip when the cursor is positioned over the options. These tool tips Note:
are available on all options and are helpful when setting the variables. 



125 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

7. Select Virtualization Plug-in, and click Next. 

 

8. Select VMware vCloud Director, and click Next. 

 

9. Enter the following information associated with the vCloud Director environment and click Next: 

a. URL 

b. System-level user name 

c. Password 
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 The URL is generally formatted as https://<IP>/cloud. Snap Creator currently supports Note:
tenant-based backups, which require entering credentials at the system level rather than at 
the organization level. 

 

10. After authentication with vCloud Director, select the organizations, vDCs, or vApps to back up. Click 
Next. 

 If an organization or vDC is selected for backup, all vApps and associated VMs within that Note:
organization or vDC are backed up. 

 If the vApp is selected, the vDC does not have to be selected separately. Note:
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 To create vApp-consistent backups, the vCloud Director plug-in creates VMware Snapshot Note:
backups of each VM associated to the vApps selected in the backup configuration. During the 
backup workflow, commands must be issued to the vCenter server to create and delete the 
Snapshot backup of the VMs. 

11. Enter the vCenter user name and password. Click Next. 

 

 Verify that vCenter ports for Snap Creator 4.0 are set to default (80/443). Note:



128 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

12. Complete the following steps to configure the local agent settings: 

a. If the Snap Creator agent is running on the same machine as the Snap Creator server, enter the 
local host IP address (127.0.0.1) or enter the IP address of the server (vCenter) that is running 

the Snap Creator agent. 

b. Enter 9090 for the port number or enter the port number value from the installation process. 

c. NetApp recommends entering a minimum setting of 1800 seconds for the Timeout option to allow 
longer restore operations to complete correctly. 

d. Click Test Agent Connection. 

 

13. If the agent connection is active, a confirmation message is displayed. If the message does not 
appear or an error occurs, verify that the agent service is running on the local Windows server. 

14. After confirming that the agent is running properly, click OK and then click Next. 

 

15. Select the backup type and click Next. 

 Snap Creator Framework provides two types of consistent backup: a standard backup within Note:
a vSphere environment and an application-consistent backup in addition to the vSphere 
backup. In this example, a VM-consistent backup is created. If the Hypervisor + App backup 
option is selected, the configuration wizard launches the corresponding application or 
database plug-in configuration after the VM configuration wizard process is complete. 

To complete the setup, follow the instructions provided for the application or the database plug-in. 

 More complex Snap Creator Framework configurations may include quiescing and Note:
unquiescing applications within a VM (refer to the instructions in the application-specific 
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section of this document). For more information on configuration settings, refer to the Snap 
Creator Community site. 

 

16. Provide the appropriate controller login information: 

a. Transport 

b. Controller/Vserver Port 

c. Clustered ONTAP status 

 

http://communities.netapp.com/community/products_and_solutions/databases_and_enterprise_apps/snapcreator
http://communities.netapp.com/community/products_and_solutions/databases_and_enterprise_apps/snapcreator
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17. If Yes was selected from the clustered ONTAP drop-down list, complete the following steps: 

a. Click Add. 

b. Enter the cluster IP address, user name, and password. 

c. Click Save. 

18. Select the newly added cluster from the Primary Cluster drop-down list and click Next. 

 Additional cluster credentials can be added if required. Note:

 

19. From the Controller/Vserver Credentials window, click Add to enter the virtual storage server 
(Vserver) or 7-Mode controller IP address or hostname, user name, and password. 

20. In the dialog box, select the volumes to include in the backup and click Save to return to the 
Controller/Vserver Credentials window. 

21. Click Next. 
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22. Provide the required Snapshot copy information and click Next. Use the following example to help 
determine appropriate settings for a Snapshot copy: 

a. Name: daily_backup (this name is based on the configuration name and on the policy name) 

b. Enable Policy: Daily 

c. Retention: Four Snapshot copies 

d. Policy Retention Age: Seven days 

e. Naming convention: Timestamp 

 NetApp recommends selecting Recent for Naming Convention if multiple VMs across multiple Note:
storage controller volumes are being backed up. 
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23. Select the appropriate settings for Data Protection and click Next. 

 An option is also available to trigger a replication after the Snapshot copy backup has Note:
completed. If SnapMirror or SnapVault is configured for the volumes associated with the 
VMware datastores that are being backed up, Snap Creator Framework triggers a SnapMirror 
and/or SnapVault update operation after the backup workflow is completed. 

 SnapMirror or SnapVault relationships must already exist. Snap Creator updates these Note:
relationships, but it does not create them. 
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24. Select the Operations Manager Alert or Protection Manager checkbox to set the integration with 
OnCommand Unified Manager (formerly Operations Manager and Protection Manager) and click 
Next: 

a. To send Operations Manager alerts when backups are completed, select the Operations 
Manager Alert checkbox and enter the host, user name, password, and port. 

b. If Protection Manager is in use, select the Protection Manager checkbox. 

 

25. Review the settings on the Summary page and click Finish to create the configuration file. 
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26. After the configuration file is created, close the Configuration tab, click the Refresh button under 
Profiles and Configurations, and reopen the configuration file by clicking the configuration file name in 
Backup Profiles. 

27. Verify that all of the settings on the Management Configurations page are complete. If VMs are stored 
across multiple NetApp storage controllers, click the Add button in the Configuration window under 
Filer Login Credentials to add new controllers and credentials as required. 

9 Conclusion 

The NetApp vCloud solution presented in this document provides a solid foundation for building a cloud 

services environment. This solution covers multiple use cases across multiple customer environments. 

The flexibility and scalability of this solution enables any customer to start out with a correctly configured 

cloud storage environment that can grow with and adapt to their evolving cloud environment. 

References 

Supporting Documents 

The following supporting documents were used for this document: 

 TR-3298: RAID-DP: NetApp Implementation of Double-Parity RAID for Data Protection 

 TR-3437: Storage Subsystem Resiliency Guide  

 TR-3450: High-Availability Pair Controller Overview and Best Practices 

 TR-3505: NetApp Deduplication for FAS and V-Series Deployment and Implementation Guide 

 TR-3749: NetApp Storage Best Practices for VMware vSphere 

 TR-4068: VMware vSphere 5 on NetApp Data ONTAP 8.1 Operating in Cluster-Mode 

 Installing the NetApp NFS Plug-in 1.0 for VMware VAAI 

 NetApp Flash Cache Technical Specifications 

 NetApp OnCommand System Manager 

 NetApp Virtual Storage Console 

 Virtual Storage Console 4.1 for VMware vSphere Installation and Administration Guide 

 vCenter Server and Host Management Guide 

 vCloud Director Installation and Upgrade Guide 

 vCloud Director Administrator’s Guide 

 vCloud Directors User’s Guide 

 VMware vCloud Director 5.1 Documentation Center 

 vShield Administration Guide 

 vShield Installation and Upgrade Guide 

 What’s New in VMware vSphere 5.0 – Storage 

 What’s New in VMware vSphere 5.1 – Storage 

Version History 

Version Date Document Version History 

Version 1.0 August 2013 Initial release 

http://www.netapp.com/us/media/tr-3298.pdf
http://media.netapp.com/documents/tr-3437.pdf
http://media.netapp.com/documents/tr-3450.pdf
http://media.netapp.com/documents/tr-3505.pdf
http://media.netapp.com/documents/tr-3749.pdf
http://media.netapp.com/documents/tr-4068.pdf
https://library.netapp.com/ecm/ecm_get_file/ECMP1118624
http://www.netapp.com/us/products/storage-systems/flash-cache/flash-cache-tech-specs.html
http://www.netapp.com/us/library/datasheets/ds-2932.html
http://www.netapp.com/us/library/datasheets/ds-3057-virtual-storage.html
http://support.netapp.com/documentation/productlibrary/index.html?productID=30048
http://pubs.vmware.com/vsphere-50/topic/com.vmware.ICbase/PDF/vsphere-esxi-vcenter-server-50-host-management-guide.pdf
http://pubs.vmware.com/vcd-51/topic/com.vmware.ICbase/PDF/vcd_51_install.pdf
http://pubs.vmware.com/vcd-51/topic/com.vmware.ICbase/PDF/vcd_51_admin_guide.pdf
http://pubs.vmware.com/vcd-51/topic/com.vmware.ICbase/PDF/vcd_51_users_guide.pdf
http://pubs.vmware.com/vcd-51/index.jsp?topic=%2Fcom.vmware.vcloud.admin.doc_51%2FGUID-DD1A073A-E230-4F47-8EEA-CE418D8E1152.htmlhttp://pubs.vmware.com/vcd-51/index.jsp?topic=%2Fcom.vmware.vcloud.admin.doc_51%2FGUID-DD1A073A-E230-4F47-8EEA-CE418D8E1152.html
http://www.vmware.com/pdf/vshield_51_admin.pdf
http://www.vmware.com/pdf/vshield_512_quickstart.pdf
http://www.vmware.com/files/pdf/techpaper/Whats-New-VMware-vSphere-50-Storage-Technical-Whitepaper.pdf
http://www.vmware.com/files/pdf/techpaper/Whats-New-VMware-vSphere-51-Storage-Technical-Whitepaper.pdf


135 VMware vCloud Director on NetApp Clustered Data ONTAP   

 

 

Refer to the Interoperability Matrix Tool (IMT) on the NetApp Support site to validate that the exact product 
and feature versions described in this document are supported for your specific environment. The NetApp 
IMT defines the product components and versions that can be used to construct configurations that are 
supported by NetApp. Specific results depend on each customer's installation in accordance with published 
specifications. 

NetApp provides no representations or warranties regarding the accuracy, reliability, or serviceability of any 
information or recommendations provided in this publication, or with respect to any results that may be 
obtained by the use of the information or observance of any recommendations provided herein. The 
information in this document is distributed AS IS, and the use of this information or the implementation of 
any recommendations or techniques herein is a customer’s responsibility and depends on the customer’s 
ability to evaluate and integrate them into the customer’s operational environment. This document and  
the information contained herein may be used solely in connection with the NetApp products discussed  
in this document. 
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